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Thunderbird 

Thunderbird adalah program yang mampu bersaing dengan MS Outlook Express, bukan 
hanya karena fasilitas yang serupa, tetapi juga user friendly, dan gratis (freeware). 
Thunderbird, dan program-program Open Source lainnya, adalah produk yang 
dikembangkan oleh sejumlah komunitas. 

Mengapa Thunderbird? 

• User friendly,  mudah instalasinya, mudah penggunaannya. 
• Gratis, dapat di-download dari web, tanpa biaya. 
• Cross platform, tersedia untuk Windows maupun GNU/Linux operating system. 

Download dimana? 

http://www.mozilla.org/products/thunderbird/ menyediakan versi terbaru, termasuk 
extension-extensionnya. 

Bagaimana cara install? 

Download file installer file diatas, dan double-click file tersebut. 
Tutup semua program yang sedang aktif. Tekan next. 
Baca agreement, bila setuju, beri tanda pada kotak dan tekan "Next". 
Jika ingin di-install di lokasi lain, pilik kotak custom; jika tidak, pilih standard. 
Program installer akan menunjukkan dimana Mozilla Thunderbird diletakkan. 
Tekan finish. 

Profiles 

Mozilla Thunderbird menyimpan personal settings Anda, seperti e-mail, passwords dan 
extensions, kedalam sebuah profile. Profile tersebut disimpan di hard disk dalam folder 
profile. 

Menentukan letak folder profile 

Mengetahui dimana folder profile akan sangat berguna jika, misalnya, Anda ingin 
membuat backup data-data pribadi dari komputer Anda. 

• Untuk Windows XP/2000, biasanya terletak di 
%AppData%\Thunderbird\Profiles\xxxxxxxx.default\, dimana xxxxxxxx 
adalah random string yang terdiri dari 8 karakter. Buka C:\Documents and 
Settings\[User Name]\Application Data\Thunderbird\Profiles\ 

• Untuk Windows 95/98/Me, biasanya terletak di C:\WINDOWS\Application 
Data\Mozilla\Thunderbird\Profiles\xxxxxxxx.default\ 

%AppData% adalah jalan pintas ke Application Data di Windows 2000/XP. Untuk 
menggunakannya, klik Start > Run..., masukkan %AppData% dan tekan Enter. Anda akan 
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diarahkan menuju ke folder Application Data, yang sebetulnya adalah C:\Documents dan 
Settings\[User Name]\Application Data. 

Membuat profile baru 

 

Untuk membuat profile baru, gunakan Profile Manager. Untuk memulai Profile Manager, 
bisa memanggilnya dari menu, atau ikuti petunjuk sebagai berikut: 

1. Tutup Thunderbird (select File > Exit from the main menu of Thunderbird). 
2. Pilih Start > Run... dari Windows Start menu. 
3. Ketik thunderbird.exe -ProfileManager dan tekan OK. 

Anda akan melihat menu Profile Manager seperti gambar diatas. Dari Profile Manager 
Anda dapat remove dan rename profiles. 

 

Klik Create Profile... untuk memulai Create Profile Wizard. Klik Next dan masukkan nama 
profile, misalnya dengan menggunakan nama Anda. 

Anda juga dapat menentukan letak profile di harddisk, sangat berguna untuk meng-export 
settings ke komputer lain atau melakukan setup di lain waktu. 

Klik Finish untuk mengakhiri pembuatan profile baru. 

Mem-backup profile 

Membackup profile di Thunderbird sangat mudah. Ikuti petunjuk sebagai berikut: 

1. Matikan Thunderbird (File > Exit). 
2. Copy folder profile ke, misalnya, CD-RW atau hard disk lain untuk tujuan backup. 

Memindahkan existing profile atau me-restore backed up profile 
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Sangat memungkinan untuk memindah folder profile. Caranya adalah sebagai berikut: 

1. Matikan Thunderbird (File > Exit). 
2. Pindahkan folder profile ke lokasi tujuan. Misalnay, pindahkan profile dari 

C:\Documents and Settings\[username]\Application 
Data\Thunderbird\Profiles\xxxxxxxx.default ke D:\Stuff\MyMailProfile 

3. Buka profiles.ini dengan sebuah text editor. Letaknya ada di application data 
folder untuk Thunderbird:  

o Untuk Windows XP/2000, letaknya di %AppData%\Thunderbird\ 
o Untuk Windows 95/98/Me, biasanya di C:\WINDOWS\Application 

Data\Thunderbird\ 
4. Didalam profiles.ini, cari lokasi profile yang sudah dipindah. Ganti isi Path= 

dengan lokasi yang baru. 
5. Ganti IsRelative=1 menjadi IsRelative=0. 
6. Save profiles.ini dan restart Thunderbird. 

Configuration 

Saat menjalankan Thunderbird untuk pertama kalinya, Anda perlu membuat account baru. 
Pertama klik "Create a new account". 
Pilih "Email account" dan tekan next.  
Masukkan nama and alamat email, tekan next. 
Type incoming server pilih IMAP apabila tetap ingin menyimpan email di server. Pilih 
POP apabila seluruh email ingin diambil ke komputer Anda. 
Untuk incoming server, isi dengan “peter.petra.ac.id”, begitu pula untuk outgoing server, 
tekan next. 
Untuk user name isi dengan login Anda, contoh: "justin", kemudian tekan next. 
Berikutnya akan ditanyakan account name, bisa diisi terserah, misalnya justin@petra.ac.id, 
kemudian tekan next. 
Lihat summary yang akan ditampilkan, cek seluruh informasi, apabila semua OK tekan 
finish. 
Anda akan ditanya password, isi dan tekan OK, Anda juga dapat memilih Thunderbird 
untuk mengingat password Anda. 
 

Penjelasan hot-bar: 

Get Mail: 

 

Tombol ini digunakan untuk mencari dan men-download e-mail baru dari mail server. 
Akan ada petunjuk apabila Anda mendapatkan e-mail baru di Inbox. 

Write: 
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Untuk menulis e-mail message, memberi attachments dan mengirimkannya. 

Address Book: 

 

Reply: 

 

Akan terbuka window baru untuk e-mail balasan. 

Reply all: 

 

Membalas e-mail ke semua recipients, misalnya: membalas ke semua yang ada di “To”. 

Forward: 

 

Delete: 

 

Bisa dilakukan juga dengan tombol delete pada keyboard. 

Junk: 

 

Menandai e-mail yang ditunjuk sebagai junk (atau disebut juga dengan spam). 

Print: 

 

Untuk mencetak e-mail yang ditunjuk. 
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Stop: 

 

Memberhentikan aktifitas download atau kirim e-mail, misalnya membatalkan pengiriman 
email yang ukurannya besar. 

Membuat signature: 

Gunakan notepad atau text editing program lainnya, dan save file sebagai plain text. 
Menggunakan signature adalah sebuah pilihan, tidak harus ada. Save signature dan 
letakkan di lokasi yang dapat Anda tentukan sendiri. 

Bagaimana memasang signature: 

Jalankan Thunderbird, buka Tools--> Account Settings. 

 

• Highlight e-mail address di menu sebelah kiri. 

• Tandai kotak yang berbunyi "Attach this signature". 

• Tekan tombol choose/browse, untuk lokasi file signature Anda. 

• Tekan OK. 
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Menulis dan mengirim e-mail: 

Ada dua cara, pertama dengan tombol Write di hotbar, atau tekan "new message" dari 
menu Message, kemudian akan muncul window baru, disitu Anda ketik e-mail untuk 
kemudian dikirim (Send). 

Alamat tujuan ditulis di “To”, alamat kedua dan seterusnya dapat diketik di baris 
berikutnya atau berjejer dengan yang pertama dengan menggunakan koma sebagai tanda 
pemisah diantaranya. 

Pada "Subject " diisi dengan topik e-mail, jika tidak mengisi subject (tidak diharuskan) 
maka pada saat pengiriman Anda akan mendapatkan konfirmasi apakah memang akan 
mengirim e-mail tersebut tanpa subject. 

Attachments: 

Tulis e-mail baru / “Write” atau new message. 

 

Tekan tombol attachment, atau di sebelah kanan tombol terdapat panah kebawah; Anda 
mendapat 2 pilihan, untuk attach sebuah file atau web address. Klik tombol attachment, 
dan browse folders untuk file dari dalam hard disk. 

Cari lokasi dan tentukan file-nya, kemudian tekan open. Maka pesan e-mail tersebut 
mempunyai attachment. Ulangi lagi prosesnya jika Anda memiliki attachment lain (lebih 
dari 1 file attachment). Untuk attach sebuah web page, pilih "Attach web page" dan isi 
URL-nya (misalnya http://www.mozilla.org). 

Address book dan hotbar: 
 

 

 

 7 of  25 



Pelatihan Komputer Universitas Kristen Petra - Januari 2007 

New card: 
 

 

Untuk menambah card baru di address book, sebuah card bisa untuk menyimpan informasi 
data teman, rekan bisnis dan lain sebagainya. 

New list: 
 

 

Untuk membuat mailing list.  Mailing list yang berupa grup yang terdiri dari beberapa user 
/ alamat e-mail untuk bisa sekaligus dikirim. 

Properties: 
 

 

Untuk meng-edit informasi card yang dipilih (highlighted). 

Write: 
 

 

Menulis e-mail ke user yang dipilih (highlighted) dari address book. 

Delete: 
 

 

Menghapus user/card dari address book. 

Salah satu fitur andalan Thunderbird adalah spam (junk) mail filter. Thunderbird memiliki 
built-in filter yang dapat diatur dan di-tuning sesuai kebutuhan. Butuh waktu seminggu 
atau lebih untuk mengenalkan spam dan non-spam, namun cukup membantu. 
Untuk setting spam filter, buka Tools > Junk Mail Controls maka akan tampil: 
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Gambar diatas menunjukkan setting untuk account tertentu, karena beda account bisa 
mempunya filter settings yang berbeda.  
 

  

The junk button 

   

Thunderbird menggunakan metode "Bayesian filtering", untuk mengajarkan mail client 
membedakan mana yang spam dan non-spam. Pilih e-mail yang dimaksud dan tekan 
tombol junk, dan bisa ditandai sebagai "Junk" atau "Not junk". Ini akan melatih 
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Thunderbird untuk mengenal spam dan non-spam. Setelah beberapa minggu Thunderbird 
lebih dapat mengenal spam yang masuk ke inbox Anda.  

Images 

Cara lain mengatasi spam adalah dengan: disable remote images from loading. Gunanya 
untuk tidak menampilkan (loading) gambar yang berada di sebuah e-mail. Buka Edit > 
Preferences dan disable "Loading of remote images" – ini akan memberhentikan spammers 
yang mendeteksi alamat e-mail Anda dengan menggunakan images (file gambar), dan 
mengurangi jumlah spam yang akan diterima. 

 
 

  
 

Importing e-mail and addresses 

Buka Tools > Import, ada 3 pilihan untuk importing e-mail dan address books. 

Importing mail 
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Pilih Mail untuk importing e-mail, kemudian klik next. 

 

  

Pilih client e-mail yang akan di-import, misalnya Outlook Express, tekan next. Finish. 
Lakukan langkah serupa untuk importing Address Book. 

Filters, sorting e-mail ke folder lain 

Misalnya kita ingin memfilter e-mail dari sebuah mailing list ke suatu folder selain Inbox. 
Langkah pertama adalah membuat folder baru, misalnya "Sales". 
 

 
 
Letakkan di "Local folders" jika ingin langsung disimpan di komputer Anda, atau pilih 
lokasi folder di server. 
 

 

 11 of  25 



Pelatihan Komputer Universitas Kristen Petra - Januari 2007 

Buka Tools > Message Filters, untuk membuat aturan filter baru tekan "New", akan akan 
ditampilkan menu sebagai berikut: 

 

 

Beri nama filter, misalnya "Sales". Kemudian tentukan rule-nya, misal email yang To-nya 
mengandung e-mail address sales@nidelven-it.no akan masuk ke folder "Sales" dan diberi 
label ‘Important’.  Klik "OK": 

 

 

Inilah filter baru. Anda bisa melakukan settings/add/remove/disable/enable filters. 
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Webmail – mail.petra.ac.id 
 
Konfigurasi identitas e-mail: sangat diperlukan agar penerima e-mail mengenal nama 
pengirim, tidak hanya e-mail address saja yang kurang informatif karena kadang-kadang 
alamat e-mail tidak sama dengan nama lengkap. 
Login ke webmail, pilih menu Options: 
 
     
Options 
 
Lalu Personal Information pilih Default Identity, klik ‘Edit your identities’, kemudian 
setelah halaman baru muncul, pada combo-box ‘Select an identity’ pilihlah Default 
Identity, kemudian isi ‘Your full name’ dengan nama lengkap Anda. Lengkapi informasi 
lainnya bisa perlu, kemudian tekan ‘Change’. 
 

 
 
Dengan demikian e-mail Anda akan diterima oleh penerima dengan dilengkapi nama 
lengkap Anda disamping alamat e-mail yang tertera di header. 
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Mengganti Password 
 
Mengganti password e-mail dapat Anda lakukan sendiri namun dengan syarat mengetahui 
password yang dimiliki sekarang. Pilih menu ‘Password’ dan akan muncul sebagai berikut: 
 

  
 
Masukkan login Anda di kotak Username, password lama di Old password, kemudian 
tentukan password yang baru, isi di dua tempat ‘New password’ dan ‘Confirm new 
password’. Pilih server yang digunakan (peter.petra.ac.id) kemudian klik ‘Change your 
password’. 
 
Menghapus e-mail 
 
Apabila e-mail sudah ditandai untuk dihapus, dengan ‘Delete’, maka jangan lupa untuk 
melakukan ‘purge deleted’ agar e-mail tersebut betul-betul dihapus. Jika tidak maka e-mail 
tersebut masih memenuhi mailbox Anda. 
 
Address Book 
 
Pilih menu ‘Address Book’ untuk melakukan search, menambah contact, bahkan Import / 
Export Address Book ke mail client lain seperti Outlook dan Thunderbird. 
 

 
 
Menu Address Book diawali dengan ‘Search’, ini gunanya untuk mencari informasi 
contact yang pernah kita isi di Address Book tersebut. Jika dikosongkan dan tombol search 
ditekan maka akan menampilkan seluruhnya, atau sama seperti menu ‘Browse’. 
Format ‘comma separated values’ adalah yang paling umum digunakan untuk melakukan 
export maupun import informasi ke program lain (dari dan ke Thunderbird / Outlook): 
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Hasil export akan berupa text file dengan format csv, begitu pula proses import sebaiknya 
berformat csv (comma separated values).
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Tutorial Microsoft Outlook 
 
diambil dari: 
Piotun Y Simanjuntak 
piotun@depkeu.go.id 
 
Lisensi Dokumen: 
Copyright © 2003 IlmuKomputer.Com 
Seluruh dokumen di IlmuKomputer.Com dapat digunakan, dimodifikasi dan disebarkan 
secara bebas untuk tujuan bukan komersial (nonprofit), dengan syarat tidak menghapus 
atau merubah atribut penulis dan pernyataan copyright yang disertakan dalam setiap 
dokumen. Tidak diperbolehkan melakukan penulisan ulang, kecuali mendapatkan ijin 
terlebih dahulu dari IlmuKomputer.Com. 
 
Kuliah Umum IlmuKomputer.Com 
Copyright © 2003 IlmuKomputer.Com 
 
1. PENGENALAN OUTLOOK 
Ms Outlook adalah sebuah aplikasi pengelolaan klien email dan workgroup yang 
dikeluarkan oleh Microsoft, salah satu perusahaan software terbesar pimpinan Bill Gates. 
Aplikasi Outlook ini membantu kita dalam pengelolaan email yang tentunya lebih praktis 
dibandingkan dengan menggunakan internet. Biasanya MS Outlook menjadi paket dalam 
MS Office, sehingga untuk menginstallnya dapat dilakukan bersama-sama dengan MS 
Office. 
Selain untuk pengelolaan email, Outlook juga mempunyai beberapa fasilitas lain seperti 
pengelolaan kalender kerja, meeting, jadwal tugas dll. Sebenarnya feature MS Outlook 
akan lebih optimal apabila di sisi servernya menggunakan MS Exchange. 
Sebelum menggunakan Outlook ada baiknya terlebih dahulu kita mengenal menu-menu 
utama dari Outlook itu sendiri. Bagian-bagian dari Outlook sbb: 
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Folder List 
Folder List menampilkan semua folder yang ada, seperti Inbox, Personal Folders, dan 
Public Folders. 
 
Toolbar 
Toolbar berisi shortcuts dari perintah yang umum digunakan, seperti "New Mail Message", 
"Print", dan "Print Preview". 
Note: Toolbar dapat diubah sesuai dengan keperluan/keinginan kita. 
 
Status Bar 
Status Bar menunjukkan banyaknya pesan yang ada pada folder yang ditunjuk, dan berapa 
banyak pesan yang belum dibaca jika ada. 
 
Outlook Bar 
Sama seperti Folder List, Outlook Bar berisi shortcuts untuk fasilitas yang ada pada 
Microsoft Outlook, seperti Calendar, Contacts, and Tasks. 
 
2. OUTLOOK UNTUK PENGELOLAAN EMAIL 
 
2.1 Membaca Email 
 
Untuk membaca email pastikan Outlook berada pada folder “Inbox”, cukup dobel klik 
pada pesan yang ingin dibaca. Pesan akan terbuka pada jendela baru. 
Untuk mengetahui adanya pesan baru, pada windows toolbar ( sudut kiri monitor ) akan 
diberi tanda amplop yang diiringi dengan suara “ding” sebagai bunyi default untuk email 
yang tiba pada Outlook. 
 
2.2 Membaca File Attachment 
 
Jika Anda menerima pesan berisi file lampiran (attachment), di folder Inbox pada Outlook 
akan di beri tanda paperclip disebelahnya. Untuk membuka file attachment lakukan 
langkah berikut : 
1. Buka pesan/mail message. 
2. Akan ada icon dengan nama file di body text. 
3. Dobel klik icon file. File attachment akan terbuka sesuai dengan program aplikasinya. 
Anda bisa menyimpannya atau menutup saja filenya. 
Cara menyimpan file attachment. 
1. Sorot file attachment 
2. Klik menu File – kemudian Save attachment. 
3. Pilih folder tempat menyimpan file yang diinginkan. 
 
2.3 Membuat Sub Folder pada Inbox. 
Apabila kita ingin mengelompokkan email dan menempatkannya pada folder tertentu hal 
ini dapat dilakukan dengan membuat folder baru di dalam folder Inbox. 
Lakukan langkah berikut : 
1. Pada folder Inbox klik File 
2. Pilih New – pilih Folder 
3. Ketik nama folder pada kolom yang tersedia. 
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2.4 Menggunakan “Message Rule” 
 
Message Rule berguna untuk mengatur email agar dapat diterima sesuai dengan aturan 
yang diinginkan. Juga berguna untuk mengelompokkan email pada folder tertentu maupun 
untuk memblok email yang tidak kita inginkan ( iklan, spam, pornografi, dsb). 
Untuk mensetting Message Rule lakukan langkah berikut : 
1. Pada folder Inbox klik menu Tools 
2. Klik “Rules Wizard” ( Akan muncul menu untuk “rules wizard”) 
3. Klik tombol New 
4. Pilih aturan sesuai keinginan (contoh “check message when they arrive” ), akan 
memeriksa email begitu tiba. 
5. Klik Next 
6. Pilih lagi sesuai aturan yang diinginkan ( contoh “with specific word in the sender’s 
address” ), akan memeriksa kata-kata khusus pada alamat pengirim. 
7. Klik kalimat “specific word” yang digaris bawah. 
8. Isi sesuai dengan kata yang kita inginkan. (Mis: Didin) 
9. Klik Next kemudian pilih “move it to the specified folder” (akan memindahkan email ke 
folder tertentu) 
10. Klik specified, akan muncul window folder daripada Outlook 
11. Pilih folder yang anda inginkan pada “Inbox” ( sub folder). 
12. Klik Next – kemudian beri nama/judul untuk message rule tadi 
13. Klik Finish 
Ada kalanya kita tidak ingin menerima email tertentu yang mengganggu. Untuk 
memblokir suatu email yang tidak kita inginkan (iklan, spam, pornographi, dsb ) lakukan 
langkah berikut : 
1. Pada folder Inbox klik Tools 
2. Klik “Rules Wizard” ( Akan muncul menu untuk “rules wizard”) 
3. Klik tombol New 
4. Pilih aturan sesuai keinginan (contoh “check message when they arrive” ), akan 
memeriksa email begitu tiba. 
5. Klik Next 
6. Pilih with “specific word in the body” ( akan mencek kata-kata yang ada pada isi pesan) 
7. Kemudian ketik/tambahkan kata-kata apa saja yang ingin Anda sensor/blok. 
8. Klik Next kemudian pilih/cek “Delete it” ( akan langsung menghapus pesan bila tiba ) 
9. Klik Next – kemudian beri nama/judul untuk message rule tadi. 
10. Klik Finish 
Note: Option yang ada pada massage rule dapat dipilih sesuai dengan aturan yang kita 
inginkan pada email yang dikirim maupun yang diterima.. 
 
2.5 Membuat/mengirim Email 
 
Untuk membuat pesan (message) baru pada Outlook ikuti langkah berikut: 
1. Pada folder Inbox, klik menu File 
2. Sorot New 
3. Klik menu Mail Message 
Note: Proses ini dapat disingkat dengan menekan icon New Mail Message (sudut kiri atas) 
pada toolbar Inbox . 
Ada 3 jenis tujuan pengiriman yaitu : To, Cc dan Bcc. Deskripsinya sbb: 
• To: tujuan standar pengalamatan pesan. 
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• Cc: singkatan dari Carbon Copy. Jika Anda ingin mengirim pesan kepada seseorang, 
tetapi ingin juga memberikan copy pesan pada orang lain, cantumkan alamat emailnya 
pada kolom Cc selain pada kolom To. 
• Bcc: singkatan dari Blind Carbon Copy. Jika Anda ingin mengirim pesan pada 2 orang, 
pada koIom To dan pada kolom Bcc, keduanya akan menerima email tetapi penerima yang 
ada dikolom To tidak akan mengetahui (blind) bahwa email juga dikirim kepihak ke 2 
(Bcc). 
 
Setelah menentukan bagaimana dan kemana pesan akan dikirim, ikuti langkah berikut : 
1. Klik tombol pengalamatan (addressing) (To, Cc, or Bcc). 
2. Pada kolom "Show Names From The :" , pastikan address list yg benar telah dipilih, klik 
tanda panah down untuk memilih. 
3. Dobel klik ( tekan To->, Cc->, Bcc-> ) nama orang yang ingin dikirim. Anda dapat 
memilih 
lebih dari satu nama dengan dobel klik pada nama tsb. 
4. Klik tombol OK . Anda akan kembali ke menu pesan/New Mail Message dengan alamat 
email yang telah dipilih tadi. 
5. Masukkan text pada halaman isian pesan. 
6. Setelah selesai mengetik pesan klik tombol Send, dan pesan akan segera dikirim.. 
 
2.6 Pemakaian Group 
 
Anda dapat mengirim email ke Group tertentu, yang terdiri dari gabungan beberapa alamat 
email. Hal ini berguna untuk memudahkan pengiriman email ke banyak alamat sekaligus 
dalam satu Group daripada menuliskan alamat email satu-persatu. Untuk membuat Group 
akan dibahas pada bab selanjutnya. Untuk mengirim ke Group lakukan langkah berikut : 
1. Klik “To” pada pengiriman email. Akan muncul menu Address Book. 
2. Pada kolom “Show Names from the : “ pilih All Groups ( atau ditempat mana anda 
membuat groups). 
3. Klik Ok dan Send 
 
2.7 Mengirim Attachments ( file lampiran) 
 
Jika Anda ingin menyertakan sebuah file atau lebih pada pesan Anda, seperti dokumen 
atau spreadsheet, 
lakukan langkah berikut: 
1. Seperti biasa, buat pesan baru beserta elamat emailnya. 
2. Setelah selesai mengetik pesan tekan tombol Insert pada toolbar. 
3. Klik File. 
4. Cari file yang ingin anda sertakan. 
5. Dobel klik pada file yang akan disertakan 
Note: Icon Attach File (gbr paperclip) merupakan jalan singkat untuk menyertakan file: 
Setelah itu file akan dimasukkan ke dalam pesan dan siap disertakan. Cara singkat lain 
adalah dengan drag and drop file dari desktop atau Windows Explorer ke body pesan. 
Bisaanya masing-masing server email membatasi besar file yang dikirim sesuai 
kemampuan. Misalnya Email domain depkeu.go.id untuk saat ini besarnya file attachment 
dibatasi sebesar 1 Mb. 
 
2.8 Membalas ( Reply ) Pesan 
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Ketika menerima dan telah membaca sebuah pesan (email) kemungkinan Anda ingin 
langsung membalas pesan ke orang yang mengirimnya. Untuk melakukan hal tersebut 
lakukan langkah berikut : 
Standard Reply 
1. Pada folder Inbox doble klik email yang ingin Anda balas. 
2. Klik tombol Reply . 
3. Alamat pengirim akan otomatis tercantum pada bagian To: 
4. Ketik pesan anda pada body pesan. 
5. Klik Send. 
 
Reply To All 
Fungsi reply to all akan membalas pesan kepada semua penerima pesan yang dituju oleh 
pengirim pertama. 
Untuk melakukan ini : 
1. Klik tombol reply to all. 
2. Semua penerima akan tercantum di bagian To : dan semua alamat bagian Cc akan 
tercantum pada bagian Cc : juga 
3. Ketik pesan anda pada body pesan. 
4. Klik tombol send. 
 
2.9 Forward ( Meneruskan ) Pesan 
 
Ketika Anda sudah membaca pesan, dan Anda ingin juga menyampaikan/meneruskan 
pesan tersebut 
ke orang lain, lakukan langkah berikut : 
1. Buka email/pesan yang ingin Anda teruskan ke orang lain. 
2. Klik tombol Forward . 
Masukkan alamat email penerima. Anda dapat menambahkan komentar di body text pesan 
jika diinginkan. 
3. Setelah selesai, klik Send. 
 
2.10 Pemakaian Signature 
 
Kita juga dapat menyertakan “signature” atau tanda tangan elektronik, biasanya 
ditempatkan pada bagian bawah email kita. Signature terlebih dahulu dibuat formatnya 
sehingga sewaktu mengirim email tidak perlu dilakukan berulang-ulang tetapi secara 
otomatis akan tertera pada bagian bawah email kita. Untuk melakukannya ikuti langkah 
berikut: 
1. Pada Outlook klik menu Tools 
2. Pilih Options 
3. Pilih Mail Format ( ada di atas ) 
4. Kemudian klik tombol “Signature” akan muncul window untuk mengedit “signature” 
5. Pilih New – masukkan nama untuk “signature” Anda. 
6. Klik Next – Ketik sesuai yang Anda inginkan, demikian juga anda bisa memilih warna 
dan bentuk dari font. 
7. Klik Finish 
Signature biasanya berisi jabatan dan alamat pengirim e-mail, sehingga penerima dapat 
mengenal identitas pengirim. 
 
2.11 Format Font & Background 
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1. Pada menu Outlook klik menu Tools 
2. Pilih Options 
3. Pilih Mail Format ( ada di menu atas ) 
4. Pilih format email pada “Send in this message format” : pilih HTML 
5. Klik Font untuk memformat font 
6. Klik Stationery Picker untuk memformat background 
7. Klik Ok 
 
3. PENGELOLAAN PERSONAL ADDRESS BOOK/ALAMAT 
EMAIL 
 
Outlook menyediakan fasilitas Address Book untuk mengelola semua alamat email yang 
ada, mengelompokkannnya secara personal maupun dalam beberapa Group. 
Personal Address Book berisi alamat e-mail beserta informasi atau data-data dari orang 
yang ingin Anda simpan. Untuk membuka Personal Addres Book lakukan langkah2 
berikut : 
1. Klik menu "Tools" pada toolbar. 
2. Klik "Address Book". 
Secara otomatis (default) akan menampilkan “Global Address List” yang berisi alamat e-
mail yang telah terdaftar. 
 
3.1 Menambah alamat email ke Outlook Address Book : 
 
Untuk menambah alamat email ke Outlook Address Book, lakukan langkah berikut : 
1. Klik tanda panah dibawah "Show Names from the:" pilih Outlook Address Book 
2. Klik File. 
3. Klik New Entry. 
4. Pilih New Contact from the list and klik "OK". 
5. Pada isian Full Name, ketik nama lengkap. 
6. Pada isian Email : ketik alamat lengkap e-mail orang tersebut. 
Setelah itu klik tombol “Save and Close“. 
Anda juga dapat menambah informasi lain tentang user tersebut, seperti alamat, no telp, 
perusahaan, dll dengan mengisi kotak yang tersedia. 
 
3.2 Global Address Book 
 
Global Address Book berisi semua user yang terdaftar. Anda dapat mengaksesnya dengan 
mengklik tombol (icon ) Address Book pada toolbar. 
 
3.3 Membuat Group ( Distribution List) 
 
Pada Address Book kita juga bisa membuat beberapa Group yang merupakan gabungan 
dari beberapa personal email, yang berguna bagi kita dalam pengiriman email. Sehingga 
memudahkan kita dalam pengiriman email ke banyak orang tanpa mengetik alamat email 
mereka satu-persatu. 
Untuk membuat “Group” lakukan langkah berikut : 
1. Buka menu “ Address Book” 
2. Klik File – pilih “New Entry” 
3. Pilih “New Distribution List “ klik Ok 
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4. Tulis nama dari Group pada kolom yang tersedia ( mis : Bintek ) 
5. Kemudian Klik tombol “Select Member” untuk memilih siapa saja yang masuk dalam 
Group ini. 
6. Pilih siapa saja dengan mengklik 2 kali pada nama atau mengklik tombol “Add” 
7. Klik Ok 
8. Kemudian klik “Save and Close” 
Maka kita dapat melihat pada menu Address Book di folder “Contacts” akan terdapat 
Group baru bernama “Bintek”. Group ini bisa dimasukkan nantinya dalam pengalamatan 
email. Kita dapat melihat semua Group yang ada pada folder “All Groups” beserta semua 
anggotanya dengan mengklik 2 kali pada group yang diinginkan. 
Note: Dari default Global Adress Book yang terdapat di mail server Bintek, telah ada 
beberapa Group default yang di bagi berdasarkan tugas dan bidangnya masing-masing. 
Dapat dilihat pada pilihan “Show All Groups” 
 
4. KALENDER KERJA DI OUTLOOK 
 
Selain untuk pengelolaan email, Outlook juga mempunyai fasilitas lain dalam pengelolaan 
jadwal aktifitas kita disebut “ Calendar”. Sama seperti Kalender biasa, Calendar pada 
Outlook juga berisi tanggal, bulan dan tahun ditambah dengan jamnya. Kelebihan pada 
Outlook in, Calendar dapat diisi, diedit dan ditambahkan informasi sesuai dengan kegiatan 
kita dan memberikan warn/peringatan pada kita apabila waktunya tiba. 
Untuk pengelolaan Calendar, lakukan langkah berikut : 
1. Pada bagian “Folder List” klik “Calender” , maka akan muncul menu sbb: 
2. Kemudian pilih tanggal yang ada pada kalender ( sebelah kanan ), akan muncul jam 
dibagian tengah berwarna kuning ( kuning gelap menandakan waktu yang telah lewat). 
3. Klik File, kemudian pilih New, kemudian pilih Appointment ( bisa dilakukan singkat 
dengan dobel klik pada jam yang diinginkan) akan muncul menu untuk Appointment. 
4. Isilah kotak subject rapat/kerja, lokasi dan waktu sebagi isian minimal. Apabila 
diperlukan isilah lebih lengkap lagi seluruh fasilitas yang ada. 
5. Kemudian Save & Close, Ini adalah langkah yang penting, sebab apabila tidak 
dilaksanakan maka data rencana kerja/rapat anda akan hilang dan tidak tersimpan dalam 
komputer. 
Lakukan berulang sesuai kebutuhan . 
 
5. PENGELOLAAN RAPAT/METTING PADA OUTLOOK 
Sama juga seperti kalender kerja, Outlook juga bisa dimanfaatkan untuk menjadwal Rapat, 
sekaligus mengundang melalui email siapa-siapa saja yang harus datang menghadiri rapat. 
ntuk menjadwalkan dan mengundang rapat pada Outlook lakukan langkah berikut : 
1. Pada menu Calendar tadi, klik pada tanggal dan jam rapat yang diinginkan. 
2. Klik File, pilih New, kemudian pilih dan klik “Meeting Request” 
3. Akan muncul menu untuk rapat kemudian isi kolom hari, jam, topik rapat dan 
keterangan lainnya 
4. Pada kolom “To” Anda dapat memilih siapa-siapa saja yang akan diundang untuk 
mengikuti rapat. 
5. Klik Send, maka undangan rapat akan terkirim ke masing masing orang yang diundang. 
Setelah menerima email undangan rapat ini maka mereka diminta untuk memberikan 
jawaban. Dan pengirim rapat menunggu jawaban dari peserta rapat. 
Apabila kita menerima undangan rapat seperti diatas akan diberikan 3 pilihan untuk me-
respond ke pengirim: 
- Pilih Accept, apabila kita dapat menghadiri rapat. 
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- Pilih Tentative, apabila kita belum jelas bisa atau tidak menghadiri rapat. 
- Pilih Decline, apabila kita jelas tidak bisa menghadiri rapat. 
Setelah kita me-respond undangan rapat maka pengundang rapat otomatis akan menerima 
dan mengetahui status dari kita, bisa atau tidak untuk mengikuti rapat. 
 
6. OUTLOOK UNTUK PROGRAM KERJA/TASK 
 
Outlook juga menyediakan fasilitas “Task” untuk mengatur program kerja supaya mudah 
untuk diingat. 
Disini user dapat mendaftarkan setiap pekerjaan yang sudah, akan, maupun yang sedang 
dikerjakan. 
Lengkap beserta detail pekerjaan berupa, lama pekerjaan, tenggat waktu, persentase 
penyelesaian dsb. 
Untuk membuat/mendaftarkan task/pekerjaan lakukan langkah berikut : 
1. Pada “Folder List” klik “Task”. Akan muncul disebelah kanan daftar daripada pekerjaan 
berupa baris. 
2. Pada menu File pilih New kemudian klik Task (bisa juga dilakukan dengan mengklik 
kanan mouse dan memilih “New Task” pada body task). 
3. Isi kolom sesuai dengan keterangannya. 
4. Jangan lupa untuk menyimpannya dengan mengklik tombol “Save and Close” 
Dengan adanya daftar pekerjaan ini, kita bisa mencek kembali daftar pekerjaan kita apabila 
suatu saat dibutuhkan. 
 
7. SETTING OUTLOOK 
 
Sebelum memakai Outlook, terlebih dahulu dilakukan setting atau setup, agar Outlook 
dapat dipergunakan sebagaimana mestinya. Disini akan dijelaskan secara umum cara men-
setting di Outlook, dengan contoh domain petra.ac.id 
Apabila MS Outlook belum pernah di setup 
1. Buka Ms Outlook . Akan muncul kotak jendela untuk Microsoft Outlook Setup Wizard. 
2. Check “Microsoft Exchange Server” pada pilihan yg ada. Konfigurasi ini khusus bagi 
anda yang menggunakan mail server Exchange. 
3. Klik Next akan muncul jendela “Microsoft Exchange Server” 
4. Ketikkan nama server misalnya peter.petra.ac.id 
5. Kettikan user id pada kotak mailbox : mulyadi 
6. Pilih “No” pada “Do you travel with this computer” 
7. Klik Next 
8. Klik Finish 
Untuk yang sudah pernah di setup 
1. Pada Layar desktop 
2. Klik Start 
3. Pilih Setting 
4. Klik Control Panel, akan muncul kotak dialog Control Panel seperti pada Gambar 
5. Dobel Klik icon Mail, akan muncul menu seperti gambar. 
6. Pilih Microsoft Exchange Server 
7. Klik tombol Properties, akan muncul kotak dialog Microsoft Exchange Server seperti 
gambar 
8. Ketikan pada kotak isian Micrososft Exchange Server : peter.petra.ac.id dan Mailbox 
user id dan klik tombol Check Name, akan memeriksa apakah user id telah terdaftar pada 
mail server dan apabila berhasil akan bergaris bawah 

 23 of  25 



Pelatihan Komputer Universitas Kristen Petra - Januari 2007 

9. Klik Ok – Klik Ok lagi. 
10. Tutup Control Panel 
 
Menggunakan Mail Server Non Microsoft Exchange 
MS Outlook juga dapat digunakan sebagai klien email dengan mail server non MS 
Exchange. 
Misalnya kantor anda menggunakan Mdaemon, Sendmail, postfix, atau langsung 
mendownload dari internet. Prinsipnya anda harus memasukkan nama server POP3 dan 
SMTP pada konfigurasi setup Outlook. 
 
Langkah-langkah setup nya adalah sebagai berikut : 
1. Dari menu MS Outlook, Klik Tools 
2. Pilih Email Accounts 
3. Pilih Email –> Add New E-mail Account 
4. Klik Next 
5. Pilih POP3 – klik Next 
6. Isi Kolom isian berdasarkan data yang ada 
7. Anda dapat mengetahui informasi POP3 ataupun SMTP melalui keterangan yang ada 
pada email langganan Anda atau bertanya langsung ke bagian Admin. 
8. Klik Next 
9. Klik Finish 
 
Test menggunakan Microsoft Outlook 
 
Pada Layar desktop : 
1. Dobel klik icon Microsoft Outlook, akan muncul layar Enter password 
2. Ketikan pada kotak isian : 
User Name : user id 
Domain Name : bintek 
Password : password 
Contoh : 
User Name : mulyadi 
Domain Name : bintek 
Password : mulyadi 
3. Klik Ok, akan muncul lembar kerja Microsoft Outlook 

 24 of  25 



Pelatihan Komputer Universitas Kristen Petra - Januari 2007 

Mailman – mailing list manager 
 
Mailman adalah sebuah system mailing list dimana kita dapat mengatur administrasi 
mailing list baik kita sebagai anggota mailing list maupun moderator suatu mailing list. 
Alamat website mailman bagi kita sebagai user mailing list adalah: 
 
http://peter.petra.ac.id/cgi-bin/mailman/listinfo 
 
Apabila kita bertugas sebagai moderator suatu mailing list, halaman mukanya adalah: 
 
http://peter.petra.ac.id/cgi-bin/mailman/admin 
 
Dikedua alamat tersebut tercantum sejumlah mailing list yang ada. Kita coba dahulu 
melihat konfigurasi mailing list untuk kita sebagai user (listinfo). Klik di salah satu mailing 
list yang dikenal atau mailing list dimana kita sebagai user yang berlangganan (subscribe) 
disitu. 
Yang pertama kita lakukan biasanya adalah mendapatkan akses ke mailing list manager 
untuk sebuah mailing list, yaitu dengan cara memasukkan alamat e-mail kita ke kolom 
‘Unsubscribe or edit options’, yang berada di bagian paling bawah halaman tersebut. 
Kemudian halaman baru akan muncul, klik tombol ‘Remind’ untuk mendapatkan 
password. Cek e-mail Anda.  Akan tetapi hal ini juga masih tergantung dari aturan yang 
diberikan oleh moderator. Apakah user anggota mailing list diberi hak untuk mendapatkan 
akses tersebut. 
Fasilitas yang dapat kita (sebagai anggota sebuah list) dapatkan adalah: 
- Daily message digest: untuk mengumpulkan e-mail yang di posting ke mailing list 

dalam satu hari menjadi satu e-mail per hari. 
- Melihat archive e-mail mailing list. 
- Sementara tidak menerima e-mail dari list, tapi bukan unsubscribe. 
- Dll. 
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